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New Family Housing Units Open 

On Friday, August 23, the two new family and handicapped accessible housing units were opened 

with an official open house get-together. All the donors to the International Living Center (ILC) 

campaign were invited to come see what their donations had made possible. The two manufactured 

homes have three bedrooms and two baths and are reserved primarily for visiting researcher, 

instructor and student family housing, or handicapped housing. The units are right by the back 

(south) gate, next to the bunkhouse. 

The donors all seemed quite pleased with what their money had made possible. Helen Wellman, a 

donor and volunteer for the Center, remarked that this was the first time she has actually been able 

to see the results of a donation she has made to any organization. 

The need for family housing seems to increase every year, as more students are mature and coming 

back to school to change careers or to finish an interrupted education. The Winton apartments have 

been used as family housing, but are only one bedroom with two bunkbeds, not conducive to family 

living. The donation of the Guin House on Chestnut made the first real family housing available, 

but this unit is reserved primarily for visiting researchers and instructors, and has been in high 

demand. 

Donations for the ILC ($80,000) were not enough to pay for both units and it was necessary to get a 

$60,000 loan from OSU Housing. To pay this loan off, the charges for all HMSC housing units 

have been raised slightly. The goal of affordable student housing still remains a top priority at the 

Center. 

 
 

Ship Dock Expansion Nears Completion 

As the photos accompanying this article show, the expansion of the ship dock and the construction 

of two new buildings, one just south of the old Ship Ops building and one on the expanded dock 

itself, is nearly completed. Fred Jones is hopeful that the work will be done by mid-October. The 

dock itself is basically complete, awaiting only the railing and fenders and the floating of the small 

boat dock to the shore side of the east end of the dock. 

The small building on the dock is 1800 square feet and contains a staging area, a machine shop and 

a small office. Off the east end of the dock are two mooring dolphins that will be reached by 

catwalks. 

 
 

Whiting Team Wins Oldfield/Jackman Award 



Thayne Dutson, Dean of the College of Agricultural Sciences (CAS), announced the Pacific 

Whiting Team (Michael Morrissey, Haejung An, Jae Park, Thomas Seymour of the OSU Seafood 

Laboratory; Gil Sylvia, Ag and Resource Economics; Ken Hilderbrand, Sea Grant College 

Program; and Edward Kolbe, Bioresource Engineering) is the recipient of the James and Mildred 

Oldfield/E.R. Jackman Team Award. 

This award consists of a certificate and an Oldfield Medal to each team member, and an award of 

$2,000 for the team. The award will be presented at the CAS Faculty and Staff Day on September 

17. 

In Dean Dutson's letter to each team member he states, "Through individual and cooperative 

efforts, the Pacific Whiting Research Team has contributed to the development of a new value-

added processing industry in Oregon." 

All the recipients gave a hearty thanks to the Oregon seafood industry for their support over the last 

five years as well as their cooperation in Pacific whiting research. "There is no question that 

without the support of industry an award like this would not have been possible," said Morrissey. 

In further news for Astoria, there is now a trailer on site with fencing around the parameter of the 

new Seafood Lab property. Backhoes will start digging to make room for the foundation by the end 

of the month. On Monday, August 19, Kelvin Koong, Associate Dean of the OSU Ag Experiment 

Station, Lavern Weber and Pat Lewis of the HMSC, and various City representatives, Seafood 

Consumer Center members, contractors Cal Mayer and Tim Carpenter, along with faculty, students 

and staff of the OSU Seafood Lab celebrated this turn of events with a barbecue on the new 

Seafood Lab grounds. It is estimated that it will take 11 months to complete the building and 

researchers hope to move in during the summer of 1997. 

 

 
 

Ken Hilderbrand Recognized for HACCP Work 

Ken Hilderbrand, Seafood Processing Specialist, was recently awarded a Certificate of 

Appreciation by the U.S. Department of Agriculture "for outstanding contributions and national 

leadership with the Seafood HACCP Alliance for Education and Training and developing an 

effective public-private sector coalition model to assist our nation's seafood processors provide 

safe, wholesome aquatic food products to consumers worldwide." His plaque represented "our 

recognition of your high professional standards for public service and commitment to extension 

education programming to reach and benefit our nation's diverse public constituency. 

"The collaboration among different government and non-government organizations with able 

leadership and guidance exemplifies an effective, proactive approach which will provide significant 

benefits to the seafood sector in our nation and facilitate its transition into a mandatory federal 

seafood inspection regime." 

 



 

Mark your calendars for our fall blood drive on Thursday, October 10 from 10-3. Volunteers will 

be contacting you shortly to reserve a time for you. 

 
 

Construction Update 

The finishing touches are being added to the renovated public wing: the drywall is being painted, 

the windows are being installed and the last areas of external plaster are being done. The temporary 

wall blocking the rest of the main building from the public wing is down. The patterned-glass 

windows are soon to be installed in the curved half-wall. Clean-up, repouring of walkways, and 

landscaping still remain to be done. 

Of course, once the actual building is completed, the exhibits have to be created and installed. The 

projected opening date for the public wing is now early 1997, but it is possible that the bookstore 

will be installed and lobby and auditorium will open earlier than that. The beautiful arched window 

in the bookstore makes a beautiful echo of the arch in the Yaquina Bay bridge. 

 

 
 

Fall Seatauqua Begins in September 

The new Seatauqua season begins in mid-September and offers some new classes and new 

instructors. 

Terry Morse will teach a class on Observing Insects on Friday and Saturday, Sept. 13 and 14. 

Friday evening's session will include a discussion and slides as a prelude to Saturday's field trip to 

Big Creek Reservoir. Emphasis of this workshop will be on observation, rather than collection. 

A gyotaku (Japanese Fish Printing) workshop will be taught by Pt. Orford artist Mari Lockhaas 

on Saturday, Sept. 14. An Inkfish Magazine reporter attended our last Gyotaku workshop, and an 

article on that class will appear in an upcoming issue. Mari will also teach a Nature Printing on 

Fabric workshop on Sunday, Sept. 15. 

Mike Rivers of the Oregon Parks and Recreation Dept will lead a van trip to several central coast 

lighthouses on Thursday, Sept. 19. 

Well-known Native American basketry artist Pat Gold will teach two Native American Twining 

classes, a beginning class on Saturday, Sept. 21 and an advanced class on Oct. 19. Pat's work has 

been exhibited in many gallery shows and has received quite a bit of publicity. 

Clara Jarman, a geologist from Corvallis, will lead an interesting class on coastal geological 

hazards entitled "Landslides, Earthquakes and Tsunamis" on Saturday and Sunday, Sept 21 and 

22. The class includes van trips to local hazardous sites to learn how to identify the risks, and how 

to avoid them. 



Local beader Deon DeLange will teach a beading class using the Native American brick stitch on 

two Saturdays, Sept 28 and Oct. 12. 

Contact Terri Nogler at 7-0271 to get a brochure, or to register for a class. Staff receive a 10% 

discount on registration fees. 

 
 

Improving Your Prowess As a Writer 
from The Fine Art of Technical Writing 

by Carol Perry 

·You can read. The more you read, the more you'll absorb and discern about both technique and 

artistry in writing. Indeed, the more you read, the more sensitized you'll become to the fine points 

that may elude you at the start. Don't make the mistake of assuming that "because it's in print, it's 

well written." Especially nowadays, readers are deluged with the shabby, amateurish products of 

nearly anyone with access to a word processor or desktop publishing. Teach yourself to 

discriminate. 

Read with attention to the vertebrate creature of writing: to its skeleton (order), to its body mass 

(conciseness), and to its muscle tone (vigor). Train yourself to "edit writing" as you read it. Use 

analysis as a learning tool. Examine, for instance, how you might recast a sentence, reorganize a 

paragraph, or emphasize something important. 

Read broadlynot just in the areas of special interest to you. Stretch your mind. Read general 

nonfiction: biographies, histories, "how to's," and so on. Read magazines, from weekly news 

magazines to those that popularize science, computers, and the like. Read fiction: novels, short 

stories. Read plays and poetryaloudto sensitize yourself to euphony. 

· You can pick the brains of the writers around you. Your fellow writers provide an ideal 

support group. Discuss problems you've encountered; ask others for their solutions. . . 

· You can bone up through a good reference book or a writing workshop. Browse in a well-

stocked bookstore for a book or two on writing. But shy away from the "dustcatcher," the biggest, 

most comprehensive book on the shelf. Chances are you won't use itit will overwhelm you with 

details and jargon. . . 

However, nothing you can do will do more to improve your prowess as a technical writer than 

to keep on writing. 

Embrace the vertebrate creature of writing as a friend, not foe. Why wrestle when you can tango? 

 
 

Native Oyster Mitigation Project 



As part of the conditions for the off-season pile driving permit for the new dock, the HMSC was 

required to do some mitigation work with the native oyster, Ostrea conchapila. The native oyster 

was the one that led to the development of the oyster industry originally in Yaquina Bay and was 

found from Alaska to California. The native oyster's habitat extends about five miles upriver, where 

the salinity drops too low to support them. Its numbers were greatly reduced because of the great 

market demand and growers switched to the commercial oyster, Crassostrea gigas. The gigas will 

grow here, but will not reproduce. 

Anja Robinson, with the help of Roger Sardinia, is working to bring back the native oyster to 

Yaquina Bay. Roger collected 300-400 broodstock oysters and Lee Hanson's hatchery spawned a 

very large batch, more than 300 bags of cultch. These bags are located near the pump house dock. 

This fall the oysters will be reseeded in good locations around the bay. These will be new locations, 

as the old home grounds are now used by the commercial growers raising gigas. Roger is diving to 

locate good rocky-bottomed sites where a bed of old shell can be laid before reseeding. After 

several years the oysters will mature and handle their own spawning. 

Anja points out the importance of having the native oyster back up to original levels, especially if 

the commercial growers should ever close up shop and pull out the non-native oysters. Oysters play 

a very important role in the estuarine ecosystem, filtering the water. Areas where oysters have 

much reduced numbers, such as the Chesapeake Bay, have great problems with water quality. 

Native oysters in Coos Bay are slowly coming back, as they were hard hit when the silt from the 

fire-denuded hills around the Bay covered over the oyster beds. 

 

 
 

NRC Associate Works with NMFS 

Kym Jacobson, a National Research Council Associate, started working with Mary Arkoosh in 

NMFS Northwest on August 1. Kym comes to us from a post-doc position at the Seattle 

Biomedical Research Institute, where she was working on a vaccine candidate for malaria. Kym 

earned her B.S. in Zoology (with a concurrent B.A. in French) from the University of Nevada, 

Reno and then went on for her Master's and Ph.D. in Biology from Wake Forest University. Her 

master's research was on parasites in aquatic turtles and her dissertation was on the evasion of 

complement- mediated lysis of Trypanosoma cruzi (a human parasite). 

While she is here, Kym is examining the combined effects of anthropogenic stressors and parasitic 

infection in juvenile salmonids. The parasite she is using is Nanophyetus, a trematode found in 

fresh water snails (Juga plicifera). It turns out that this area is a hot spot for this parasite and Kym 

has been collecting snails in a number of local rivers and streams. 

Kym and her husband Dave have a three-year-old son, Clayton. Dave is also a biologist and the 

three of them enjoy canoeing, hiking, camping and road biking. 

 



 
 

Library News 

The HMSC World Wide Web site continues to grow and change. If you haven't checked it out 

recently, please do so at 

http://www.hmsc.orst.edu 

We have set up a template file to use as a base for designing your own personal web page. It can be 

seen at http://www.hmsc.orst.edu/misc/template.html 

You can copy this file to your personal computer using Netscape. To do this on a Mac, select 

Document Source under the View menu, then select Save As under the File menu. To do this from 

Windows, select Save As under the File Menu and select Source (*.htm) as the type of file. Any 

word processor or editor may be used to edit the file, but be sure to save the file as a text file. There 

are also free HTML editors available over the web which make setting up a web page fairly easy. 

An HTML file is a text file which has the embedded tags (like <H1>) which web browsers like 

Netscape can interpret. 

For assistance in setting up a web page or if you have any comments or suggestions about the 

HMSC site, please contact Susan Lynds at lyndss@ucs.orst.edu. 

 
 

Personnel Notes 

Congratulations to two newly wed couples! Valerie Shaffer married Sean Edward Harmon in 

Gordonsville, Virginia, in June. Valerie was a research assistant for Chris Langdon and moved on 

to an aquaculture job at VIMS. Kathy Maas married Steven Hebner, a detective with the State 

Police, in July. Special credit goes to Glenn Gioseffi, who was the matchmaker. Kathy and Steve 

are back from their honeymoon diving off the Gulf of Mexico. 

Bon voyage to Jerry Bisson, who is leaving LB&B at the EPA facility for a new job in Minnesota! 

Jerry has worked as a plumber here for six years. 

Congratulations are in order for two of our former graduate students. Nora Demers has taken a 

position as visiting laboratory biologist at Evergreen State College in Olympia, Washington. Nora 

just completed her Ph.D. in Zoology. Matt Smith will be working for the Nisqually Tribe on their 

geoduck aquaculture as of September. Matt recently completed his Master's in Fisheries. 

Former graduate student Bob Stuart returned to the HMSC as a guest lecturer for the Aquatic 

Toxicology workshop offered at the Center this July. He was working with his major professor, 

Lavern Weber. 
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